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About @ONE

As California’s community colleges take on the challenge of effectively integrating
technology into instruction and services, they do so with the goals of increased student
access and improved student outcomes. The @ONE project has been funded by the
California Community Colleges Chancellor’s Office to build a statewide training
infrastructure with an electronic learning community as an integral support and
connection for faculty throughout the state. The @ONE project is a faculty driven
community college consortium that is dedicated to providing resources to community
college faculty and staff to support learning and students in the 21st century.

@ONE Mission

The mission of @ONE is to assist California Community College faculty and staff to
enhance student learning and success through expanded uses of effective technology
by providing training, online resources and support.

About this Guide

This booklet contains information about working with drawing objects in Office XP and
assumes familiarity with the Windows operating system and Microsoft Word XP.

We would like to thank De Anza College for providing us with the original documentation
from their “Using the Drawing Toolbar in Office 97/98” that provided the framework for
this material.

Permission to Use & Reprint @ONE Training Materials

Modification, reprinting and distribution of these training materials throughout the
California Community College system is authorized and encouraged, provided that
@ONE is acknowledged as the original author (e.g. add this line before reprinting:
"These training materials adapted with permission from @ONE, http://www.cccone.org,
[date]).

If you are outside the California Community College system and wish to use/adapt any
@ONE training materials, please contact the @ONE Office at 408.274.7900 ext. 6534,
or write to one@cccone.org, to make arrangements.

Copyright © 2005, @ONE, California Community Colleges
Evergreen Valley College * 3095 Yerba Buena Road ¢ San Jose, CA « 95135
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Unless otherwise mentioned, the instructions in this booklet apply to any Office
application.

Overview

The Drawing Toolbar allows you to create and manipulate shapes, text and other objects
in an Office document. Although the Drawing toolbar is accessible in Excel, Word and
PowerPoint, it is most commonly used only in Word and PowerPoint. The Drawing
Toolbar looks the same and performs most of the same functions no matter what Office
program you’re using. This booklet will focus on the following capabilities of the Drawing
Toolbar:

» Drawing Shapes and Lines

* Moving and Modifying Shapes

* Adding Shadows and Dimensions to Shapes

» Adding Color to Shapes

e Using Text Boxes

* Changing Object Order and Alignment

e Using WordArt

Opening the Drawing Toolbar

The Drawing Toolbar may already be open in your application window.
If you do not see the Drawing Toolbar, go to View->Toolbars=>Drawing.

When you open the Drawing Toolbar it will be, by default, aligned to the bottom of your
application window.
DLaW* Autoshapes = . w [ O [E] 4l 92 (2] d-d-A-=E=E 0 F@.

Drawing Shapes and Lines

There are four buttons/menus that allow you to place drawn shapes and lines in your
document/presentation:

| Butoshapes = ™~ w [ O

Shapes Lines Arrows Rectanale Oval

Drawing Basic Lines
1. Click on the Line button. -
2. Click and drag on your page to create a line. When your line is the
desired length, release your mouse.
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Drawing a Rectangle
1. Click on the Rectangle button. |:|
2. Click and drag on your page to create a rectangle.

Note: To create a perfect square, hold down your Shift key while dragging your
mouse.

3. When your rectangle/square is the desired size, release your mouse button.

Drawing a Shape
1. Click on the AutoShapes menu button, click on a submenu title, then click on a

shape:
:K" Lires b
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2. Click and drag in your page to create the shape.

Pt
Note: To create a symmetrical shape, hold down your Shift key <h
while dragging your mouse. ﬁ‘;ﬁ;’ﬁ+

3. When your shape is the desired size, release your mouse button.

Drawing Arrows

1. Click on the Arrow button in your Drawing Toolbar. T

2. Click and drag on your page to draw your arrow. The arrow head will be
placed in the direction you're drawing. For instance, if you draw from bottom to
top, the arrow will be at the top of your line; if you draw top down, the arrow will
be at the bottom.

3. When your arrow is the desired length, release your mouse button.

4. To select a different arrow style, click on the Arrow Style button on the =
Drawing Toolbar.

Drawing Complex Lines
1. Click on the AutoShapes button in your Drawing Toolbar, place your pointer over
Lines, and then select a line tool.
2. Click and drag with your mouse to create the line in your page. Each line tool
works a bit differently:

» The Scribble tool works just like a pencil. e%
* The Freeform tool provides you with a bit more control than the

Scribble tool. Select the Freeform tool, then click in your (5
document where you when to begin drawing, then release your mouse.
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Drag to draw a line, then click to end that line and begin another.
Continue this process until your freeform shape is drawn—double-click
when you are finished.

» The Curve tool allows you to create arches on your page. Select 5
the Curve tool, click then release your mouse where you want
the arch to begin. Drag your mouse to the point where you want the arch
to curve, the click your mouse. Drag down to complete your arch (or
continue and make more curves). Double-click when you are finished.

Moving and Modifying Lines and Shapes

Once you've drawn lines and shapes in your document/presentation, you can move,
resize, rotate, and re-color them.

Moving Lines and Shapes
1. Click once on your line or shape to select it.
2. Place your pointer over the line or in the center of the shape until your mouse
pointer becomes the “move” icon (a four-point arrow).
3. Click and hold down with your mouse and drag your line or shape to where you
want it on the page.

Resizing Lines and Shapes
1. Click once on your line or shape to select it.
2. Place your pointer over one of the white circles surrounding your object.
3. Click and drag in or out to decrease or increase the size of your object.

Note: When working with a shape, click and hold down on a corner circles, then
hold your Shift key while dragging to increase or decrease size proportionally.

Rotating Lines and Shapes

1. Click on a line or shape in your document to select it. .

2. Click the Free Rotate button. (If this tool is not visible on your toolbar, G)
go to Draw > Rotate or Flip > Free Rotate.) Green circles will appear
along the edges of your image.

3. Place your mouse over one of the green circles. Your mouse pointer , . &
will look similar to the arrows in the image to the right. rf kit

4. Click and hold down on your mouse while dragging your line or N A
shape. The image will rotate. g e

5. When you are finished, release your mouse and click on the Rotating button to
deselect the rotating tool.

Changing Line Thickness and Style
1. Click once on a line or shape to select it. o
2. Click on the Line Style tool and choose a thickness from the menu that =
appears.
3. Click on the Dash Style tool to change the design of your line. S
Changing Line and Fill Color
1. Click on a line or shape to select it. -
2. Click the arrow to the right of the Line Color button or Fill Color button and
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choose a color from the menu that appears. Alternately you can choose from the
menu:

* “More Line/Fill Colors:” If you do not see the color you like in the menu
that appears, click More Line/Fill Colors and a variety of tools will Sy
become available that allow you to customize a color.

» “Fill Effects:” If you want to add a pattern or other design to your drawing
object.

Creating Text Boxes

Text Boxes allow you to create floating areas of text in your Office documents. Text
boxes are useful if you need a small amount of text in a particular area of your page, but
you don’t want it to interrupt the flow of the main text in your document/presentation. For
instance, the following caption was placed inside a text box:

A view of the neighborhood at dusk. Ours is the
house with the green light in front.

Creating a Text Box e
1. Click on the Text Box button. =
2. Click and drag in your document to create a text box.
3. When your text box is the desired size, release your mouse button. Your text box
will become selected (it will have circles around it) and your cursor will be inside.
4. Type in your text box. You can format the text in a text box as you would any
other text in Office.

Selecting a Text Box

There is a difference between making a text box active and selecting it. When a text box
is active, you can type in it; when it is selected you can make universal changes to the
text box (fill color, line color, font, etc.).

* To activate a text box click once inside it. The text will be surrounded by slanted
lines, white circles and a green circle, which make up a slanted-line selection
box. The white circles, called resize handles, are used to change the text box
size. The green circle rotates or changes the direction of the text box.

* To select a text box click once on the outside edge of the box OR click once
inside the text box, then once on the outside edge. The text will be surrounded by

9“'/;f’,f’;f’,f’;f’,»",4f’,»",4f’,f",4f’,f’;f’,»’;f’,»"zI’,f’;f’,f’;f’,»",4f’,»",4f’,ffaf’,f’;f’,»’;f’/’//’.-{g,‘I

G Active text box -
'15"'/’5"/.//.//.//.//.//X/X/H/X/X/X/X/X/X/X/Xﬂg i

Selected text box
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small dots, resize handles and a rotation handle, which make up a dotted
selection box.

Changing Line and Fill Color
To change line and fill color, select your text box, and then follow the instructions on
page 8.

To Change Font Color
1. Select your text box or highlight the text within the text box. A |
2. Click on the arrow to the right of the Font Color button. S
3. Select a color from the menu that appears OR select More Colors to customize
your font color.

Changing Text Box Direction
When a text box is selected, the Text Box Toolbar should automatically appear. If you do
not see the Text Box Toolbar, go to View->Toolbars—>Text Box.

To change the text box direction: T
1. Select your text box. :
2. Click on and hold the green rotation handle at the top of the box with your
mouse.
3. Rotate the text box in the desired direction.

Adding Shadows and Dimensions to Objects

You can add shadows or dimensions to any line, shape or text box.

Adding Shadows .
1. Click on a line, shape or text box to select it.
2. Click on the Shadow Style button at the bottom of your Drawing Toolbar.
3. Select a shadow style from the menu that appeatrs.

Note: If you want more options, select Shadow Settings. To remove the shadow,
select No Shadow from the Shadow Style menu.

Adding Dimensions
1. Click on a line, shape or text box to select it.
2. Click on the 3-D Style button at the bottom of your Drawing Toolbar.
3. Select a dimension option from the menu that appears and release your mouse
button. The dimension will appear around your object.

Note: If you want more options, select 3-D Settings. To remove the shadow,
select No 3-D from the 3-D Style pop-up menu.
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Changing Object Order and Alignment

The ability to change object order allows you to “stack” shapes and lines on J S
top of one another. The alignment options allow you to make multiple images “-===
horizontally or vertically aligned on your page. Object order and alignment menus can be
accessed from the Draw button.

Change Object Order
For this to work, you must have more than one object or image in your
document/presentation.
1. Drag one shape or image on top of another shape or
image. | T,
Click on the top object to select it. !
Click on the Draw button, place your pointer over Order, | Send toBack
RE
[

Ering to Front
2.
3.

and then choose an arrangement option from the menu Ering Forward

that appears. For instance, to send the top object to the !
|

back, select Send to Back. Send Backward

Change Object Alignment
For this to work, you must have more than one object or image in your
document/presentation.

1. Click on one object, hold down your Shift key and click ;

on the other object (this allows you to select = align Left
multiple items). Continue Shift-clicking until all & Align Center
objects you want to align are selected. = Align Right

Release the Shift key. !
Click on the Draw button, place your pointer over Align | it Align Tap

and Distribute, and select an alignment option from of  Align Middle
the menu that appears.

wnN

il Align Botkom

Relative to Slide
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WordArt

WordArt enables you to create text that has shape, shadows, multiple colors and
dimensions.

Create Text with WordArt
1. Click on the WordArt button. The WordArt Gallery window will appear. "

Warddr Gallery ﬁlﬁl

Saluck i Whordiect ilyda:

qud-"’t pordan, I'I-nl.u Wardart | £ w

|w wontasy | -Wocdhet [V A
|ihm irdhrt |Mardhet (Wit fooeritic!] w
-

e e

2. Click once on a design option in the WordArt Gallery window, and then click OK.
An Edit WordArt Text window will appear.

3. Type the text you would like to appear in your WordArt in the space provided.
You can also change font and font size. When you are finished, click OK. Your
WordArt will appear in your document and the WordArt toolbar will appear.

Modifying WordArt

You can modify increase or decrease the size of your WordArt, move your WordArt, and
change the order of your WordArt as you would any other drawing object. To make other
modifications (fill color, shape, etc.), you will need to use the WordArt toolbar.

The WordArt Toolbar
The WordArt Toolbar should appear any time a WordArt object is selected. If you do not
see the WordArt toolbar, go to View->Toolbars>WordArt.

Wordart - xi
Al EdiText.. T ¥y o a3 b = E‘f|
1 2 3 4 5 6 7 89

Add new WordArt.

Edit the text in your WordArt.

Change the style of your WordArt.

Change the fill and line color.

Change the shape.

Make capitalized and lower-case letters the same height.
Flip your WordArt.

Center the text in your WordArt if it is more than one line.
Change the spacing in your WordArt.

CoNor®WNE
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@creative
/commons

Attribution-NonCommercial-ShareAlike 2.5

CREATIVE COMMONS CORPORATION IS NOT A LAW FIRM AND DOES NOT
PROVIDE LEGAL SERVICES. DISTRIBUTION OF THIS LICENSE DOES NOT
CREATE AN ATTORNEY-CLIENT RELATIONSHIP. CREATIVE COMMONS
PROVIDES THIS INFORMATION ON AN "AS-IS" BASIS. CREATIVE COMMONS
MAKES NO WARRANTIES REGARDING THE INFORMATION PROVIDED, AND
DISCLAIMS LIABILITY FOR DAMAGES RESULTING FROM ITS USE.

License

THE WORK (AS DEFINED BELOW) IS PROVIDED UNDER THE TERMS OF THIS
CREATIVE COMMONS PUBLIC LICENSE ("CCPL" OR "LICENSE"). THE WORK IS
PROTECTED BY COPYRIGHT AND/OR OTHER APPLICABLE LAW. ANY USE OF
THE WORK OTHER THAN AS AUTHORIZED UNDER THIS LICENSE OR
COPYRIGHT LAW IS PROHIBITED.

BY EXERCISING ANY RIGHTS TO THE WORK PROVIDED HERE, YOU ACCEPT
AND AGREE TO BE BOUND BY THE TERMS OF THIS LICENSE. THE LICENSOR
GRANTS YOU THE RIGHTS CONTAINED HERE IN CONSIDERATION OF YOUR
ACCEPTANCE OF SUCH TERMS AND CONDITIONS.

1. Definitions

a. "Collective Work" means a work, such as a periodical issue, anthology or
encyclopedia, in which the Work in its entirety in unmodified form, along with a
number of other contributions, constituting separate and independent works in
themselves, are assembled into a collective whole. A work that constitutes a
Collective Work will not be considered a Derivative Work (as defined below) for
the purposes of this License.

b. "Derivative Work" means a work based upon the Work or upon the Work and
other pre-existing works, such as a translation, musical arrangement,
dramatization, fictionalization, motion picture version, sound recording, art
reproduction, abridgment, condensation, or any other form in which the Work
may be recast, transformed, or adapted, except that a work that constitutes a
Collective Work will not be considered a Derivative Work for the purpose of this
License. For the avoidance of doubt, where the Work is a musical composition or
sound recording, the synchronization of the Work in timed-relation with a moving
image ("synching") will be considered a Derivative Work for the purpose of this
License.

c. "Licensor" means the individual or entity that offers the Work under the terms of
this License.

d. "Original Author" means the individual or entity who created the Work.

e. "Work" means the copyrightable work of authorship offered under the terms of
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this License.

f. "You" means an individual or entity exercising rights under this License who has
not previously violated the terms of this License with respect to the Work, or who
has received express permission from the Licensor to exercise rights under this
License despite a previous violation.

g. "License Elements" means the following high-level license attributes as
selected by Licensor and indicated in the title of this License: Attribution,
Noncommercial, ShareAlike.

2. Fair Use Rights. Nothing in this license is intended to reduce, limit, or restrict any
rights arising from fair use, first sale or other limitations on the exclusive rights of the
copyright owner under copyright law or other applicable laws.

3. License Grant. Subject to the terms and conditions of this License, Licensor hereby
grants You a worldwide, royalty-free, non-exclusive, perpetual (for the duration of the
applicable copyright) license to exercise the rights in the Work as stated below:

a. toreproduce the Work, to incorporate the Work into one or more Collective
Works, and to reproduce the Work as incorporated in the Collective Works;

b. to create and reproduce Derivative Works;

c. to distribute copies or phonorecords of, display publicly, perform publicly, and
perform publicly by means of a digital audio transmission the Work including as
incorporated in Collective Works;

d. to distribute copies or phonorecords of, display publicly, perform publicly, and
perform publicly by means of a digital audio transmission Derivative Works;

The above rights may be exercised in all media and formats whether now known or
hereafter devised. The above rights include the right to make such modifications as are
technically necessary to exercise the rights in other media and formats. All rights not
expressly granted by Licensor are hereby reserved, including but not limited to the rights
set forth in Sections 4(e) and 4(f).

4. Restrictions. The license granted in Section 3 above is expressly made subject to
and limited by the following restrictions:

a. You may distribute, publicly display, publicly perform, or publicly digitally perform
the Work only under the terms of this License, and You must include a copy of,
or the Uniform Resource Identifier for, this License with every copy or
phonorecord of the Work You distribute, publicly display, publicly perform, or
publicly digitally perform. You may not offer or impose any terms on the Work
that alter or restrict the terms of this License or the recipients' exercise of the
rights granted hereunder. You may not sublicense the Work. You must keep
intact all notices that refer to this License and to the disclaimer of warranties. You
may not distribute, publicly display, publicly perform, or publicly digitally perform
the Work with any technological measures that control access or use of the Work
in a manner inconsistent with the terms of this License Agreement. The above
applies to the Work as incorporated in a Collective Work, but this does not
require the Collective Work apart from the Work itself to be made subject to the
terms of this License. If You create a Collective Work, upon notice from any

(c) 2005 @ONE http://www.cccone.org 9




Licensor You must, to the extent practicable, remove from the Collective Work
any credit as required by clause 4(d), as requested. If You create a Derivative
Work, upon notice from any Licensor You must, to the extent practicable, remove
from the Derivative Work any credit as required by clause 4(d), as requested.

b. You may distribute, publicly display, publicly perform, or publicly digitally perform
a Derivative Work only under the terms of this License, a later version of this
License with the same License Elements as this License, or a Creative
Commons iCommons license that contains the same License Elements as this
License (e.g. Attribution-NonCommercial-ShareAlike 2.5 Japan). You must
include a copy of, or the Uniform Resource ldentifier for, this License or other
license specified in the previous sentence with every copy or phonorecord of
each Derivative Work You distribute, publicly display, publicly perform, or publicly
digitally perform. You may not offer or impose any terms on the Derivative Works
that alter or restrict the terms of this License or the recipients' exercise of the
rights granted hereunder, and You must keep intact all notices that refer to this
License and to the disclaimer of warranties. You may not distribute, publicly
display, publicly perform, or publicly digitally perform the Derivative Work with
any technological measures that control access or use of the Work in a manner
inconsistent with the terms of this License Agreement. The above applies to the
Derivative Work as incorporated in a Collective Work, but this does not require
the Collective Work apart from the Derivative Work itself to be made subject to
the terms of this License.

c. You may not exercise any of the rights granted to You in Section 3 above in any
manner that is primarily intended for or directed toward commercial advantage or
private monetary compensation. The exchange of the Work for other copyrighted
works by means of digital file-sharing or otherwise shall not be considered to be
intended for or directed toward commercial advantage or private monetary
compensation, provided there is no payment of any monetary compensation in
connection with the exchange of copyrighted works.

d. If you distribute, publicly display, publicly perform, or publicly digitally perform the
Work or any Derivative Works or Collective Works, You must keep intact all
copyright notices for the Work and provide, reasonable to the medium or means
You are utilizing: (i) the name of the Original Author (or pseudonym, if applicable)
if supplied, and/or (ii) if the Original Author and/or Licensor designate another
party or parties (e.g. a sponsor institute, publishing entity, journal) for attribution
in Licensor's copyright notice, terms of service or by other reasonable means, the
name of such party or parties; the title of the Work if supplied; to the extent
reasonably practicable, the Uniform Resource Identifier, if any, that Licensor
specifies to be associated with the Work, unless such URI does not refer to the
copyright notice or licensing information for the Work; and in the case of a
Derivative Work, a credit identifying the use of the Work in the Derivative Work
(e.g., "French translation of the Work by Original Author," or "Screenplay based
on original Work by Original Author"). Such credit may be implemented in any
reasonable manner; provided, however, that in the case of a Derivative Work or
Collective Work, at a minimum such credit will appear where any other
comparable authorship credit appears and in a manner at least as prominent as
such other comparable authorship credit.

e. For the avoidance of doubt, where the Work is a musical compaosition:
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i. Performance Royalties Under Blanket Licenses. Licensor reserves the
exclusive right to collect, whether individually or via a performance rights
society (e.g. ASCAP, BMI, SESAC), royalties for the public performance
or public digital performance (e.g. webcast) of the Work if that
performance is primarily intended for or directed toward commercial
advantage or private monetary compensation.

ii. Mechanical Rights and Statutory Royalties. Licensor reserves the
exclusive right to collect, whether individually or via a music rights agency
or designated agent (e.g. Harry Fox Agency), royalties for any
phonorecord You create from the Work ("cover version") and distribute,
subject to the compulsory license created by 17 USC Section 115 of the
US Copyright Act (or the equivalent in other jurisdictions), if Your
distribution of such cover version is primarily intended for or directed
toward commercial advantage or private monetary compensation.

f. Webcasting Rights and Statutory Royalties. For the avoidance of doubt,
where the Work is a sound recording, Licensor reserves the exclusive right to
collect, whether individually or via a performance-rights society (e.g.
SoundExchange), royalties for the public digital performance (e.g. webcast) of
the Work, subject to the compulsory license created by 17 USC Section 114 of
the US Copyright Act (or the equivalent in other jurisdictions), if Your public
digital performance is primarily intended for or directed toward commercial
advantage or private monetary compensation.

5. Representations, Warranties and Disclaimer

UNLESS OTHERWISE MUTUALLY AGREED TO BY THE PARTIES IN WRITING,
LICENSOR OFFERS THE WORK AS-IS AND MAKES NO REPRESENTATIONS OR
WARRANTIES OF ANY KIND CONCERNING THE WORK, EXPRESS, IMPLIED,
STATUTORY OR OTHERWISE, INCLUDING, WITHOUT LIMITATION, WARRANTIES
OF TITLE, MERCHANTIBILITY, FITNESS FOR A PARTICULAR PURPOSE,
NONINFRINGEMENT, OR THE ABSENCE OF LATENT OR OTHER DEFECTS,
ACCURACY, OR THE PRESENCE OF ABSENCE OF ERRORS, WHETHER OR NOT
DISCOVERABLE. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF
IMPLIED WARRANTIES, SO SUCH EXCLUSION MAY NOT APPLY TO YOU.

6. Limitation on Liability. EXCEPT TO THE EXTENT REQUIRED BY APPLICABLE
LAW, IN NO EVENT WILL LICENSOR BE LIABLE TO YOU ON ANY LEGAL THEORY
FOR ANY SPECIAL, INCIDENTAL, CONSEQUENTIAL, PUNITIVE OR EXEMPLARY
DAMAGES ARISING OUT OF THIS LICENSE OR THE USE OF THE WORK, EVEN IF
LICENSOR HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

7. Termination

a. This License and the rights granted hereunder will terminate automatically upon
any breach by You of the terms of this License. Individuals or entities who have
received Derivative Works or Collective Works from You under this License,
however, will not have their licenses terminated provided such individuals or
entities remain in full compliance with those licenses. Sections 1, 2, 5, 6, 7, and 8
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will survive any termination of this License.

b. Subject to the above terms and conditions, the license granted here is perpetual
(for the duration of the applicable copyright in the Work). Notwithstanding the
above, Licensor reserves the right to release the Work under different license
terms or to stop distributing the Work at any time; provided, however that any
such election will not serve to withdraw this License (or any other license that has
been, or is required to be, granted under the terms of this License), and this
License will continue in full force and effect unless terminated as stated above.

8. Miscellaneous

a. Each time You distribute or publicly digitally perform the Work or a Collective
Work, the Licensor offers to the recipient a license to the Work on the same
terms and conditions as the license granted to You under this License.

b. Each time You distribute or publicly digitally perform a Derivative Work, Licensor
offers to the recipient a license to the original Work on the same terms and
conditions as the license granted to You under this License.

c. If any provision of this License is invalid or unenforceable under applicable law, it
shall not affect the validity or enforceability of the remainder of the terms of this
License, and without further action by the parties to this agreement, such
provision shall be reformed to the minimum extent necessary to make such
provision valid and enforceable.

d. No term or provision of this License shall be deemed waived and no breach
consented to unless such waiver or consent shall be in writing and signed by the
party to be charged with such waiver or consent.

e. This License constitutes the entire agreement between the parties with respect to
the Work licensed here. There are no understandings, agreements or
representations with respect to the Work not specified here. Licensor shall not be
bound by any additional provisions that may appear in any communication from
You. This License may not be modified without the mutual written agreement of
the Licensor and You.

Creative Commons is not a party to this License, and makes no warranty whatsoever in
connection with the Work. Creative Commons will not be liable to You or any party on
any legal theory for any damages whatsoever, including without limitation any general,
special, incidental or consequential damages arising in connection to this license.
Notwithstanding the foregoing two (2) sentences, if Creative Commons has expressly
identified itself as the Licensor hereunder, it shall have all rights and obligations of
Licensor.

Except for the limited purpose of indicating to the public that the Work is licensed under
the CCPL, neither party will use the trademark "Creative Commons" or any related
trademark or logo of Creative Commons without the prior written consent of Creative
Commons. Any permitted use will be in compliance with Creative Commons' then-
current trademark usage guidelines, as may be published on its website or otherwise
made available upon request from time to time.

Creative Commons may be contacted at [http://creativecommons.org/]
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